# Table of Contents

Contents

Getting Access to your ASA hosted Website ......................................................................................................................... 3
Requesting a new section Website on ASA Servers ............................................................................................................... 3
Once You are in the System.................................................................................................................................................... 3
My WorkBench....................................................................................................................................................................... 5
Editing Existing Content......................................................................................................................................................... 5
Creating New Content............................................................................................................................................................. 9
Images and Files ................................................................................................................................................................... 10
  Insert an embedded image............................................................................................................................................. 10
  Aligning an image to the left or right........................................................................................................................... 11
  Making an image link ....................................................................................................................................................... 11
Uploading a PDF File ........................................................................................................................................................... 11
Guidelines for Section Website Content .............................................................................................................................. 12
ASA Maintained Section Content: Section Landing Pages .................................................................................................. 13
Update Schedule for ASA Maintained Section Pages ......................................................................................................... 14
**Getting Access to your ASA hosted Website**

In order to edit your section website you’ll need to register your account on the ASA website. You can do this by logging into the member portal- the same way that you would if you were renewing your membership for the year. If you’ve already logged into the new system before you can skip this step.

Next notify the Sections Manager that you are the web volunteer for your section. The Sections Manager will assign your section to you, once you get an email back you should be able to navigate to your site and edit it.

*NOTE: If your section does not have a website hosted on the ASA server you do not need to do this step. There will be no pages that you can edit. Instead reach out to your predecessor in the section to gain access to a website hosted off ASA.*

**Requesting a new section Website on ASA Servers**

If you would like to set up a new section website on ASA contact the Sections Manager. They can activate a website for your section. You will be responsible for getting the website up and running however. If you are migrating a site from another host it may just be a matter of copying and pasting the content.

**Once You are in the System**

1. Go to the ASA website
2. Click on member Login
3. Log in using your ASA member credentials
4. You should be logged in to the ASA member portal. Click on the ASA logo to be taken to the main ASA website.
5. You should be taken to the main site with the message on the upper right saying “Logout” which indicates you are now logged in to the system.
6. Upon entering you should see a similar screen to the screenshot below
7. Please note the upper left links should say: Add Content, My Workbench and Help
8. Add Content will allow you to create pages for your Section’s subsite only in the CMS
9. My Workbench will allow you to create content and also identify for you what Section you have permissions to edit (My Workbench >> My Sections)
1. My Workbench will have three tabs
   a. My Content
   b. Create content
   c. My Sections
2. My Content will show you what content exists for your Section, if it is published, when it was last updated, etc.
3. Create Content – clicking on the “ASA Section Content” link will allow you to create web pages for your Section subsite only
4. My Sections will show you what Sections you have permissions to edit and create content

**Editing Existing Content**

1. Go to My Content. Select an item you would like to edit. Click on its title
2. You will be taken to the page with a screen similar to below. Click on the “Edit” tab to open the WYSIWYG editing controls for the page
CALL FOR NOMINATIONS 2016 G&TS AWARDS

Deadline: March 1, 2016

Nominations (including self-nominations) are now being accepted for the 2016 Global and Transnational Sociology awards. The deadline for all nominations is March 1, 2016, and the winners will be announced at the ASA annual meeting in Chicago. The awards are described below.

[1] Best Scholarly Book Award

The Global and Transnational Sociology Section solicits nominations (including self-nominations) for the 2016 Best Scholarly Book Award, recognizing an outstanding book published in 2014 or 2015 in the area of Global and Transnational Sociology. When nominating a book, please include a brief comment (a couple of paragraphs) on its contribution to the global and transnational sociology field. The deadline is March 1, 2016. Please direct any inquiries to the committee chair, Zsuzsa Gille.

Please send a copy (or ask the publisher to send copies) of the book and the supporting materials to each of the 4 members of the committee:

Zsuzsa Gille (committee chair) - Department of Sociology, University of Illinois at Urbana-Champaign, 3120 Lincoln Hall, 702 S Wright Street, M/C 454, Urbana, IL 61801
gille@illinois.edu

Claire Laurier-Decoteau – Department of Sociology, University of Illinois at Chicago, 4112 Behavioral Sciences Building, 1007 West Harrison Street (MC 312), Chicago, Illinois 60607-7140
decoteau@uic.edu

2010 COUNCIL
2010 SECTION AWARDS
2010 COUNCIL
2011 AWARDS
2011 COUNCIL
CALL FOR NOMINATIONS - GLOBAL AND TRANSNATIONAL SOCIOLOGY AWARDS FOR 2012
2012 AWARDS
2012 COUNCIL
DENVER 2012: GLOBAL AND TRANSNATIONAL SOCIOLOGY SECTION
ASA PRE-CONFERENCE
CALL FOR NOMINATIONS - 2013 GLOBAL AND TRANSNATIONAL SOCIOLOGY AS SECTION AWARDS
2013 AWARDS
2013 COUNCIL
GRADUATE STUDENT MENTORING LUNCHEON AT ASA 2013
2014 AWARDS
2014 COUNCIL
3. The page with editable controls open will look like the screenshot below. You may edit the text and save it once done by scrolling to the very bottom and clicking on “Save.” NOTE: if you open a document but don’t end up making any edits, no need to save it. Just click on the “View” tab to exit the WYSIWYG.
4. When editing a piece of content, one of the required fields is "Site Tree." Please select Sub sites. Otherwise, if you are not prompted to select it by the system, no need to worry about it.
Creating New Content

1. Clicking on “Add Content” will take you to the screen below which is a WYSIWYG where you can add images, text and other web content for your section.
2. Scrolling to the very bottom of the page are several tabs. One of them is called “Publishing Options.” If you click on that, you will see several checkboxes. Your content will not be live and published unless the “Published” checkbox is checked off.

Images and Files

Insert an embedded image

Inserting an Embedded Image into a rich-text editor (inline)

All rich-text editors on the site include an “Add Media” button.

Click on this button to open the media browser. From here, the first screen available will allow you to upload a file. This tool supports images, videos, audio, and documents. When you upload the file, the tool will determine the appropriate file type and customize the next steps to match.

You will be given the opportunity to provide additional data that will exist with the file you upload. Adding this data here will cause it to display wherever it is used across the site.

You can also use existing files by clicking on the All Files, My Files, or Media Library tabs. Within these tabs you can search and filter items. To embed a file double-click on its image.
On the screen that comes up you will be able to provide overrides for the additional data associated with the file. Editing values like captions and credits here will apply only to this instance. It will not impact the data elsewhere on the site.

**Aligning an image to the left or right**

Once an image has been inserted, you can turn it into a link and you can float it to the left or right.

**Floating an image**

1. Click on the photo and then click one of the alignment buttons:

**Making an image link**

After floating the image, you can make the image into a link as usual.

1. Click the image
2. Click the Link button
3. Configure the link normally
4. By default, the credit and caption will be turned into links as well. To unlink them, click on the text, then click the unlink icon in the toolbar.

**Uploading a PDF File**

1. Log into the ASA website and navigate to Drupal
2. Go to the page you want to edit
3. Click on the Edit tab
4. Make sure under text format Rich Text (WYSIWYG) is selected. If it is you will see editing controls
5. Select the media upload button
6. OPTIONS
   a. Upload new file >> choose file from your desktop computer
   b. Use an existing file from All files in the system or the Media Library
   c. Use an existing file from only the ones you have uploaded
7. Upload new file >> Upload >> Next
8. Destination: always select Public local files served by the webserver
9. Select a value >> PDF if a PDF document, Excel if an Excel document
10. Save

**IMPORTANT: MAKE NOTE OF THE PAGENAME OR FILENAME, ESPECIALLY IF YOU UPLOADED A PDF. THE WAY DRUPAL KEEPS TRACK OF AND LOCATES PDF DOCUMENTS YOU UPLOAD IS THROUGH ITS NAME. IF YOU ARE UPLOADING A NUMBER OF DOCUMENTS OR ONE IN A SERIES OF DOCUMENTS FOR A COMMON AREA, NAME YOUR DOCUMENT IN A WAY THAT LOGICALLY TIES IT TO THE OTHER DOCUMENTS IN THE SERIES OR AREA.**
5. Examples of logically-named files to make identifying easier in Drupal
   a. OOW_Section_newsletter_January_2016.pdf
      OOW_Section_newsletter_March_2016.pdf
   b. DRG_John_Smith_headshot-jpg
      DRG_Albert_Jones_headshot.jpg

Guidelines for Section Website Content.

Content that ASA provides automatically to each section

This sort of content should generally be low priority for the section as it is either created automatically from our governance database or updated each year as part of our calendar. If you see something missing here, please let me know and I can add it to your section’s landing pages on the ASA website.

- Section Officers and Councilmembers
- Committee Rosters (This is the area I’m most likely going to need updates on)
- Awards Recipients (2016 recipients will be placed online after the Annual Meeting)
- Bylaws

Content that all sections should have on their sites

- Call for Awards announcements (Sections will be responsible for hosting and updating this information in November and December- please provide me with a URL for this so I can provide links from the main ASA site)
- Updates about section activity, such as those in newsletters
- A short introduction to the section’s topic area.

High Value Content

This is the sort of content that will likely be featured elsewhere on the site and used to showcase your section and the work of your members. In addition, these can be blog posts or news articles in your section’s newsletter.

- Content about the section’s subject area that explain concepts or introduce the section’s topic area to a general audience.
- Content relating section subject matter to current events or hot topics
- Content that showcases members’ work and achievements

Content that can go on your site, but can also be featured in other places as well

Some of this content can go on the ASA calendar and in Footnotes as well as on your section page.

- Announcements about special events throughout the year (Mini conferences, mentorship events etc). These can be sent to rasuncion-reed@asanet.org.
• Updates about member accomplishments (publishing a book, moving to a new institution, receiving a major grant etc.) These should be sent to footnotes@asanet.org.
• Images such as photos. In addition to using these for section websites, you can log into ASA’s Flickr group and upload photos https://www.flickr.com/groups/hasasociology/

ASA Maintained Section Content: Section Landing Pages

Some content related to your section on the ASA website cannot be directly edited by section volunteers. For example section landing pages, bylaws pages and past awards recipients are maintained by ASA staff. All sections receive these pages automatically and are part of the section’s archives here at ASA. They can’t be edited directly by section web volunteers but requests can be sent to the section manager for corrections and updates.

These pages have five major parts. See the diagram on the following page:

1. **Introduction message.**
   This is a brief introduction to your section. It could be a mission statement or other sort of welcome. It should be a paragraph or two at most.

2. **Section logo (optional)**
   An optional logo graphic for your section.

3. **Section Officers**
   A list of all current section officers pulled directly from ASA’s membership database. If there is an error or omission in this list then it is also in the section’s records. Committees can be added to your section’s governance record on request.

4. **ASA Communities navigation**
   Links to other pages on the ASA website. Non-editable.
   a. **Section Bylaws**
      A link to your section’s bylaws. These are a copy of the archival version at ASA. If there are any errors please contact
   b. **Past Awards recipients**
      A link to a page containing a list of the section’s past award recipients. This is part of your section’s archival records at ASA. Corrections to inaccurate information are always welcome.

5. **Section website navigation (optional)**
   Links to your section website. If you have a site hosted on ASA’s servers then all pages on your site will be linked here. If you hose a site remotely then you can request that specific pages be added or removed from these links.
Update Schedule for ASA Maintained Section Pages

Section related content maintained by ASA staff is updated on a yearly basis. During the year section chairs are asked to review updated content and determine if errors are present. Other corrections can be requested at any time however turnaround times will depend on staff availability.

**Awards Recipients**
Content is updated in October and announced in Footnotes in November.

**Bylaws**
Updated in June or July if the bylaws were approved during the spring election.

**Call for Awards Nominees**
ASA staff no longer maintains Calls for Awards Nominees. Sections should update this information in November and provide the Sections Manager with a link to the page with this information.
Section Officers
Updated the first week of September. The records are updated in June, however new section officers don’t take office until after the Annual Meeting.